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SPO Paycut Roster 
 

Introduction This section provides the procedures for creating a Paycut Roster. 

 
Purpose The Paycut Roster is intended to provide the SPO Chief/Assistant Chief a 

snapshot of all pending movement of personnel within a SPO.   
 
It is important to note that all of the steps in this guide are 
SUGGESTIONS and as you develop a Paycut Roster, you will determine 
what works best for you and your personnel. 

 
Procedures See below.  
 

Step Action 
1 Click on the Orders tile. 

 
 

2 The Airport Terminal option will display to generate the following Relation 
Type rosters and save to your desktop: 
• HRS Departures, 
• HRS Arrivals, 
• Own Unit Departures, and  
• Own Unit Arrivals   

 
 

  

Continued on next page 

https://www.dcms.uscg.mil/Portals/10/CG-1/PPC/GUIDES/GP/SelfService/Command/AirportTerminal.pdf?ver=2020-08-21-141134-777
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SPO Paycut Roster, Continued 

 
Procedures, 
continued 

 

 
Step Action 

3 Merge all four rosters into one spreadsheet with two worksheets (tabs).  Add 
both the HRS Departures and Own Unit Departures rosters to one worksheet 
labeled PCS DPT.   
 
Add both the HRS Arrivals and Own Unit Arrivals rosters to a separate 
worksheet (tab) labeled PCS RPT.   
 
Click Save As, enter a File Name, and change the Type to Excel Workbook.  It 
is recommended to name the spreadsheet Paycut Roster XXXXXXX (use the 
date of next Paycut, i.e., 06OCT20).  You should have something similar to 
below. 
   
NOTE:  You may also open a blank Excel spreadsheet and copy and paste the 
information into the new spreadsheet.   

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 

4 Once all the rosters have been combined on one spreadsheet with two 
worksheets (tabs), add the following Tabs in the following order: 
• Separations 
• Authorized PCS 
• SELRES 
• RMMs-CSPY-FSA 
• TDY A School 
• All Other TDY 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 

5 Once the tabs have been added, copy the headers from the PCS DPT tab and 
paste them to the top of each of the newly created tabs.  

 
 
After pasting the header row to the Separations tab, from the toolbar, select 
View > Freeze Panes > Freeze Top Row.   Repeat step 3 for each new tab. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 

6 Return to the PCS DPT tab.  Highlight the entire spreadsheet by clicking the 
arrow in the upper left corner of the spreadsheet.  From the toolbar under Home, 
select Sort & Filter > Custom Sort.   

 
 

7 The Sort parameters will display.  Ensure My data has headers is checked and 
using the Sort by drop-down, select Order Type.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 

8 The worksheet will now be listed with PCS orders at the top with Reserve orders 
next, then Separation, and lastly TAS.  

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 

9 Scroll down past the PCS and select all the orders that are labeled as Reserve.  
Right click and select Copy.   

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 
 

Step Action 
10 Go to the SELRES tab and right click in the first block under the header row 

and select Paste. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
11 Repeat Steps 8 & 9 to copy and paste all Separation orders to the Separations 

tab; then copy and paste all TAS under the All Other TDY tab. 
 

12 Once all the Reserve, Separation, and TAS orders have been added to the 
appropriate worksheet (tab), return to the PCS DPT worksheet, and delete the 
Reserve, Separation, and TAS orders from the PCS DPT worksheet. 
 

13 On the PCS DPT tab:  Highlight the entire spreadsheet by clicking the arrow in 
the upper left corner of the spreadsheet.  From the toolbar under Home, select 
Sort & Filter > Custom Sort. 

 
 

14 The Sort parameters will display.  Ensure My data has headers is checked and 
using the Sort by drop-down, select Status.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
15 Select all the rows with an Authorized status, right-click and select copy.  Go 

to the Authorized PCS tab, right click in the first block under the header row 
and select Paste.   

 
 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 
 

Step Action 
16 Once all the Authorized orders have been added to the Authorized PCS 

worksheet (tab), return to the PCS DPT worksheet, and delete the Authorized 
orders from the PCS DPT worksheet. 
 

17 The PCS DPT worksheet should now only list orders with a status of En route 
or Ready.  The following is optional but recommended to allow for easier 
viewing of the roster.  Highlight and delete the following columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Position Number   
• Order 
 

The header row should now match the example below:  

 
 

18 Type Comments in column L of the header row.   

 
 

19 Highlight column L and select All Borders from the toolbar, then select center 
(if necessary). 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
20 Highlight the entire worksheet and select Sort & Filter then Custom Sort. 

 
 

21 Ensure the My data has headers block is checked and select Estimated Report 
Date from the Sort by drop-down.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
22 In Column J (Estimated Report Date):   

• Highlight all dates that are past due through the current date in RED. 
• Highlight all dates from tomorrow’s date through next paycut in YELLOW. 
 
This column reflects orders that should already be departed from your SPO and 
should be reported in by the new SPO (or your SPO if it’s a fleet up/extension or 
local move). 
 
If your departed members have missed a paycut already, contact the new 
(incoming) SPO and alert them. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
23 Highlight the entire worksheet and select Sort & Filter then Customer Sort. 

 
 

24 Ensure the My data has headers block is checked and select Estimated Depart 
Date from the Sort by drop-down.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
25 In Column H (Estimated Depart Date):   

• Highlight only the dates that are past due through the current date in RED. 
• Highlight only the dates from tomorrow’s date through next paycut in 

YELLOW. 
 
Review Column E (Status) for any orders within the highlighted fields that are 
in a Ready status against any highlighted fields in Column H (Estimated Depart 
Date) and highlight that Ready Order in the corresponding color. 
 
This column reflects what your SPO is responsible for departing DA for paycut. 
 
Enter Comments as needed to pass information to the AOR field Admins or to 
your SPO staff for action.  Suggested comments include:   
• Pending Paperwork from Admin 
• SELRES 
• TEMDU 
• Pending Date Changes 
• Mbr on Med Hold 
• Mbr Pending NJP 
• Pending Trouble Ticket 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
26 Go to the PCS RPT tab.  Highlight the entire spreadsheet by clicking the arrow 

in the upper left corner of the spreadsheet.  From the toolbar under Home, select 
Sort & Filter > Custom Sort.   

 
 

27 The Sort parameters will display.  Ensure My data has headers is checked and 
using the Sort by drop-down, select Order Type.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
28 Scroll down past the PCS and select all the orders that are labeled as Reserve.  

Right click and select Delete.  Do NOT delete any Separation orders (located at 
the end), these members will be accessions to a new component. 

 
 

29 The following is optional but recommended to allow for easier viewing of the 
roster.  Highlight and delete the following columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Position Number   
• Order 
 
The header row should now match the example below: 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
30 Type Comments in column L of the header row.    

 
Highlight column L and select All Borders from the toolbar, then select center 
(if necessary). 

 
 

31 Highlight the entire worksheet and select Sort & Filter then Custom Sort. 

 
 

32 Ensure the My data has headers block is checked and select Estimated Report 
Date from the Sort by drop-down.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
33 In Column J (Estimated Report Date):   

• Highlight only the dates that are past due through the current date in RED. 
• Highlight only the dates from tomorrow’s date through next paycut in 

YELLOW. 
 
Enter Comments as needed to pass information to the AOR field Admins or to 
your SPO staff for action.   
 
NOTE:  Contact the prior SPO if any of the orders indicate a Ready or 
Authorized status. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
34 Go to the Separations tab.   

 
The following is optional but recommended to allow for easier viewing of the 
roster.  Highlight and delete the following columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Position Number   
• Order 
 
The header row should now match the example below: 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
35 Type Comments in column L of the header row.    

 
Highlight column L and select All Borders from the toolbar, then select center 
(if necessary). 

 
 

36 Highlight the entire worksheet and select Sort & Filter then Custom Sort. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
37 Ensure the My data has headers block is checked and select Status from the 

Sort by drop-down.  Click OK. 

 
 

38 In Column E (Status):  Highlight any orders in an Authorized status in 
YELLOW. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
39 Highlight the entire worksheet and select Sort & Filter then Custom Sort. 

 
 

40 Ensure the My data has headers block is checked and select Estimated Depart 
Date from the Sort by drop-down.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
41 In Column H (Estimated Depart Date):  Highlight any orders that are 

Authorized within the next 30 days in RED.  Those members REQUIRE 
signed separation orders for HHGs, etc.   
 
Enter Comments as needed to pass information to the AOR field Admins or to 
your SPO staff for action.   

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
42 Go to the Authorized PCS tab.   

 
The following is optional but recommended to allow for easier viewing of the 
roster.  Highlight and delete the following columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Position Number   
• Order 
 
The header row should now match the example below: 

 
 

43 Type Comments in column L of the header row.    
 
Highlight column L and select All Borders from the toolbar, then select center 
(if necessary). 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
44 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

45 Ensure the My data has headers block is checked and select Reason Code 
from the Sort by drop-down.  Click OK. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
46 In Column F (Reason Code):  Highlight all FLT and EXT orders in RED. 

 
These orders generally require zero paperwork and therefore should be worked 
immediately, allowing more time for the more complex PCS orders. 
 
NOTE:  If any of these require obligated service, enter OBLISERV in the 
Comments block. 

 
 

47 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
48 Ensure the My data has headers block is checked and select Estimated Depart 

Date from the Sort by drop-down.  Click OK. 

 
 

49 In Column H (Estimated Depart Date):   
• Highlight only the dates that are past due through the current date in RED. 
• Highlight only the dates from tomorrow’s date through next paycut in 

YELLOW. 
 
Enter Comments as needed to pass information to the AOR field Admins or to 
your SPO staff for action.   

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
50 Go to the SELRES tab.   

 
The following is optional but recommended to allow for easier viewing of the 
roster.  Highlight and delete the following columns (*this is different from the 
previous worksheets): 
• Order Type 
• Action 
• Reason Code 
• Depart Deptid 
• Reporting Deptid 
• Position Number   
• Order 
 
The header row should now match the example below: 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
51 Type Comments in column L of the header row.    

 
Highlight column L and select All Borders from the toolbar, then select center 
(if necessary). 

 
 

52 Highlight the entire worksheet and select Sort & Filter, then Custom Sort.

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
53 Ensure the My data has headers block is checked and select Status from the 

Sort by drop-down.  Click OK. 

 
 

54 In Column E (Status):  Highlight all Authorized orders to be approved to a 
Ready status. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
55 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

56 Ensure the My data has headers block is checked and select Estimated Depart 
Date from the Sort by drop-down.  Click OK. 

 
 

 
 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
57 Scroll through the list of orders and locate ALL short-term orders in an En route 

status.  This does NOT include long-term orders that require a Separation 
transaction to end the orders (such as Title 10 or ADOS).  If unsure, review the 
orders in DA.   
 
Mark each order or block of orders, right-click and select Delete.  Do NOT 
delete any orders in an Authorized, Ready, or En route status that require a 
separation transaction. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
58 In Column H (Estimated Depart Date):   

• Highlight all Ready orders past due through the current date in RED. 
• Highlight all Ready orders from tomorrow’s date through next paycut in 

YELLOW. 
 
Enter Comments as needed to pass information to the AOR field Admins or to 
your SPO staff for action.   

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
59 Go to the All Other TDY tab.   

 
 

60 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
61 Ensure the My data has headers block is checked and then select Departing 

Department from the Sort by drop-down.  Click OK. 

 
 

62 Scroll through the worksheet and highlight all the orders for members assigned 
to Cutters.  Right-click and select Copy.  

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
63 Go to the RMMs-CSPY-FSA tab and Paste the orders into the worksheet. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
64 On the RMMs-CSPY-FSA tab:  The following is optional but recommended to 

allow for easier viewing of the roster.  Highlight and delete the following 
columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Reporting Department 
• Position Number   
• Order 
 
The header row should now match the example below: 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
65 Type Comments in column K of the header row and type Pay Affected Status 

in column L of the header.    
 
Highlight column K and L and select All Borders from the toolbar, then select 
center (if necessary). 

 
 

66 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 
 

Step Action 
67 Ensure the My data has headers block is checked and select Estimated Depart 

Date from the Sort by drop-down.  Click OK. 

 
 

68 In Column H (Estimated Depart Date):   
• Highlight orders past due through the current date in RED. 
• Highlight orders from tomorrow’s date through next paycut in YELLOW. 
 

In the Comments field:  Enter information for the AOR field Admins such as 
“Need signed orders” or “Missing FSA worksheet”, etc.  
 

In the Pay Affected Status field:  As the SPO staff updates you, enter those 
actions here such as, “RMMs completed”, “CSPY stops on (date)”, “FSA starts 
on (date)”, etc.    
 

Optional:  Once all tasks for each row are completed, remove the red or yellow 
highlight and replace with green to show no further action required.    

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
69 Return to the All Other TDY tab. 

 
 

70 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 

 
 

 

Continued on next page 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
71 Ensure the My data has headers block is checked and select Status from the 

Sort by drop-down.  Click OK. 

 
 

72 Scroll through the data and locate all the non-rates with orders.  Highlight 
each of the orders, right-click and select Copy. 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
73 Go to the TDY A School tab.  Click in the first open in block Column A.  

Right-click and select Paste to add the data copied from the All Other TDY 
worksheet. 

 
 

74 On the TDY A School tab:  The following is optional but recommended to 
allow for easier viewing of the roster.  Highlight and delete the following 
columns: 
• Duty Type 
• Order Type 
• Action 
• Depart Deptid 
• Reporting Deptid 
• Reporting Department 
• Position Number   
• Order 
 
The header row should now match the example below: 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 
 

Step Action 
75 Type Comments in column K of the header row and type Pay Affected Status 

in column L of the header.    
 
Highlight column K and L and select All Borders from the toolbar, then select 
center (if necessary). 

 
 

76 Each row needs to be reviewed against the member’s orders in DA to verify they 
are orders for A-school.  If the orders are for A-school, enter the A-school and 
duration in the Comments field.  If the orders are NOT for an A-school, delete 
the row from the TDY A School worksheet. 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
77 After all the data on the worksheet has been reviewed and updated as 

appropriate, highlight the entire worksheet and select Sort & Filter, then 
Custom Sort.   

 
 

78 Ensure the My data has headers block is checked and select Estimated Depart 
Date from the Sort by drop-down.  Click OK. 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
79 In Column H (Estimated Depart Date):   

• Highlight orders past due through the current date in RED. 
• Highlight orders from tomorrow’s date through next paycut in YELLOW. 
 
In the Pay Affected Status field:  Initially, it is recommended this column be 
used to indicate information such as “Need signed orders”, “FSA??”, etc. as 
necessary.  As the SPO staff updates you on any actions taken, enter those 
actions here such as, “DMR starts on (date)”, “CSPY stops on (date)”, “FSA 
starts on (date)”, etc.    
 
Optional:  Once all tasks for each row are completed, remove the red or yellow 
highlight and replace with green to show no further action is required.    
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
80 Return to the All Other TDY tab. 

 
 

81 Highlight the entire worksheet and select Sort & Filter, then Custom Sort. 
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SPO Paycut Roster, Continued 

 

Procedures, 
continued 

 

 
Step Action 
82 Ensure the My data has headers block is checked then select Departing 

Department from the Sort by drop-down and the Order indicates A to Z.  Click 
+ Add Level.  Select Estimated Depart Date from the Then by drop-down and 
the Order indicates Oldest to Newest.  Click OK. 

 
 

83 No further action is required for this worksheet.  This worksheet is more a 
courtesy tab for the P&A POCs ensuring visibility of their member’s 
movements. 
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